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Introduction
The Symbol for Windows Export Program allows you to make communication symbols 
available to other programs. You can select symbols from every Symbol for Windows 
database that you have a license for. With the symbol, the program can export the word 
belonging to the symbol. When exporting a symbol, you also can edit these words. The 
program is available in several languages.

The Symbol for Windows Export Program is for everyone who wants quick and easy 
access to the symbols in other than Symbol for Windows programs. The only thing you 
need is Windows (the version 95 or newer) and a mouse. With this, you can export the 
symbols in a number of ways:
1. to a file (a bitmap, a Windows metafile, in the original format, a JPEG Image File or a 

GIF Image File)
2. to the clipboard.
3. to a printer.

For further information
For all comments, questions and remarks about the Symbol for Windows Export 
Program, or any of the other Symbol for Windows modules, please contact your dealer.

Handicom
Oranjelaan 29
3843 AA  Harderwijk 
The Netherlands 
phone: +31-341-412629
fax: +31-341-430602
e-mail: info@handicom.nl
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1. Select a symbol

The Symbol for Windows Export Program starts up with the symbol selection dialog. It 
resembles the symbol selection dialog that is used in other Symbol for Windows 
programs. The only differences are the Export button and the menu.
This chapter explains how to select a symbol.
The menu-options are listed in chapter 5.

1.1 Selecting a symbol

1.1.1 Concept names and synonyms
The list in the middle contains not symbol names but concepts instead. Of one database, 
several symbols can be linked to one concept. For instance, if there are several symbols 
for the concept ‘house’, they are all linked to the concept ‘house’.
When you click on a concept name in the list in the middle, only the first symbol that is 
linked to the concept is shown in the preview box to the right. If there are more symbols 
available for the chosen concept, the buttons Show Previous Synonym and Show New 
Synonym will be enabled, indicating the synonym number and the total number of 
synonyms available for this concept.

1.1.2 Databases
On the right, a list shows which database is currently selected. You can choose another 
database, selecting one from the list that unfolds when you click the small arrow key at 
the right of the list. The list will only show names of databases that are available for you. 

1.1.3 Categories
On the left you see the Symbol for Windows category structure. When you click on the 
name of a category, the list in the middle is filled with all concepts that occur in that 
category and in the chosen database.
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A [+] placed before the name of a category means that there are sub-categories. Click 
with the left mouse button on the [+] to unfold a category. Now you can select one of the 
sub-categories to be able to browse a smaller selection.

Options
Below the category structure you will find two options which can make searching easier:
1. If the first option is activated, the category structure functions as follows. When you 
click on the name of a category that contains subcategories, the list in the middle will be 
filled with all concepts, which occur in the chosen database as well as in the chosen 
category, and in all its sub-categories. (This is always the case when you click on the 
main category, whether this option is activated or not.)
2. When a symbol database doesn’t contain too many symbols, many categories and sub-
categories will be empty or almost empty. Check this option to remove the empty 
categories from the category structure and to place the contents of very small sub-
categories in their ‘parent’-category. When you choose another symbol database, the 
category structure will be adapted to that database.

1.2 Finding a symbol
You can browse the list in the middle very quickly by typing the first letters of the 
concept/symbol you look for. First click in the list or in the box on top of that list, and then 
start typing.

Language switch
If you'd rather see the concept and category names in another language, you can choose 
Options - Language in the menu and select the language that you want.

Find buttons
You could also use the buttons Find, Find Next and Find Previous to look for a word, part 
of a word or even a character. The (part of the) word is looked for in all categories. If a 
name is found in which the (part of the) word occurs, the category-list shows to which 
category it belongs, adding a gray background to the name of that category.

Note! Keep in mind that the names of concepts can differ from the original symbol names 
that are used within each database. And, if you are looking for a particular symbol, don’t 
forget to check synonyms!
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2. Choose the destination: file, clipboard or printer
To export a symbol, select the option File - Export option from the menu, or press the 
Export button.
You can save or print the symbol or copy it to the clipboard and open it in another 
program. First you should choose a destination.
The destination is a combination of an image type (original format, Bitmap, Metafile, 
JPEG Image File or GIF Image File) and a storage type (in a file or on the clipboard) or 
simply the printer.

2.1 Original format
Original format is just the way you have the image in the database. You can’t add text or 
colour nor change the size. 

2.2 Bitmap
Bitmaps are ‘complete’ drawings, and always include a background color. You can also 
set a text to be drawn on the image. If bitmaps are scaled, the results are often not 
optimal: when a bitmap is printed you can often see small blocks instead of smooth lines. 
Set the size of bitmaps to the best size for your purpose.

2.3 Metafile
Metafiles are scalable. This means that you do not have to set the image size. You also 
cannot set the background colour or the text. The metafile only contains the drawing 
commands for the lines that form the symbol. When such a file is used in another 
program, it does not affect the background on which it is drawn, and it is freely scaleable.

2.4 JPEG Image file
JPEG Image Files are based on the Bitmap. The difference is compression, which helps 
you to make the files smaller.

2.4.1 JPEG Settings
Press the button Settings to change the compression. 
The smaller the compression factor, the smaller the file. You can choose a factor between 
1 and 100. Compression factor 100 means actually no compression at all.
Note that the smaller the compression becomes, the quality of the image will be less 
satisfactory.  

Progressive Encoding influences the way the image is drawn on the screen. When using 
it, you first see a vague image that gets clear bit by bit. The other way (not using 
Progressive Encoding) will make the image appear on the screen in rows.
When exporting JPEG’s to the hard disk, it’s better not to have Progressive Encoding on, 
as that gives faster results.

2.5 GIF Image file
GIF Image File is also based on the Bitmap. The difference between JPEG and GIF is 
that GIF’s always have a stable compression and a maximum amount of 256 colors. The 
colors in a new image will be brought back to 256 colors or less.

2.5.1 GIF settings
Press the button Settings to choose how many colors and which colour patterns you want 
to use in the picture. Note: the more colours, the bigger the file gets! 
You can also use dithering. That helps the program – when not having the color(s) 
needed in the picture – to replace them with a pattern consisting of small dots that give an 
image of the original color. However, when there are too many colors to replace, the 
picture can become granular. There can also appear colors that do not belong to the 
original picture.
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If you don’t use dithering, the program just chooses the nearest colour available. The 
even colour surfaces that form can make the picture less sharp. 

2.6 Save to file
When you have chosen a file type you can press the Save button. In the standard 
Windows Save window you can type the file name and choose in which directory you want 
to save it. After saving the file you’ll get automatically back to the symbol selection 
window.  

2.7 Copy to the clipboard
When you have chosen a file type you can copy the file to the clipboard by pressing the 
Copy button. Immediately after that you should open it in another program by pressing on 
Ctrl+V on the keyboard or choosing the option Paste in the Edit-menu. 
After choosing Copy you’ll get automatically back to the symbol selection dialog.

Problems using the Clipboard
The metafile picture can sometimes show incorrectly in other programs, directly after it is 
pasted from the clipboard. One of these programs where this can go wrong is MS-Word. 
To solve this problem in Word you have to double-click on the symbol to open the draw 
utility, and then choose close to return to your document.
If you export the symbol from Symbol for Windows to a Metafile on disk, and then load 
this file in your Word document, it will be shown correctly.

2.8 Printing a symbol
When you want to print a symbol, choose Printer as destination. You get the same 
possibilities as when you choose Bitmap plus some extra settings.
Contrary to the other types of file, the text is now outside the picture, and doesn’t influence 
its size. You can find more about this type of destination in chapter 4. 

2.8.1 Position on the paper
There are nine possibilities for the position of the symbol on the page: in the right, in the 
middle and in the left, on three different heights: at the top, in the middle or at the bottom. 

2.8.2 Printer set-up
If you click on the Setup button, the standard printer-setup dialog will be shown. With it 
you can select a printer, the size and orientation of the paper, etc.

By pressing the Print button, the symbol is printed. If you press the Cancel button, the 
symbol won’t be printed.
If you press one of these two buttons, you will return to the main window.
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3. Settings for symbols
After choosing the destination you can specify how the selected symbol must be exported. 
Bliss has some different options; more about that in the next chapter.

This dialog allows you to control how your exported image will look. All the changes you 
make to the settings in the export window will be ‘remembered’ and used by the program 
until you change them again. Even leaving the program doesn’t change the settings.

3.1 Size
You can select one of the pre-defined sizes (100 or 200 pixels, just around or square 
around), or you can choose it on your own. If you set your own size, the Export Program 
can help you calculate the optimal width of your symbol (‘Auto width’ option), but you can 
also set your own width.

3.2 Positions
You can set the relative positions of the symbol and the text.
However, you can only choose the position for the picture if you’ve chosen the option 
“Printer”. Then there are nine possible locations, three in every “row”.

3.3 Text
In the edit-field at the left in the middle it is possible to change the text next to the symbol. 
You can enter any text you like. If your text is too long, given the size of the image and the 
font, some parts will not be shown in the picture.

3.4 Add border
This command adds a thin black line around the picture and the text. 
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3.5 Background colour
You can choose the background colour for the symbol using the colour pattern on the left 
side of the export window. This pattern consists out of 64 colours from which the user can 
create the 16 colors most below by him/herself. That happens in the colour window, 
where you also can find 48 (partly different) colors. You can open this window by pressing 
the Colour button.

3.6 Font
Press the Font button to change the font for the text. The standard font dialog appears 
where you can set the type, size and style of the font, as well as the colour of the text.

3.7 Aspect ratio
Click on the button Picture. A window with two tab menus shows. 
On the left tab menu you can choose ´keep aspect ratio´ or ´stretch´. This setting 
influences how the image is drawn if the chosen size has an aspect ratio that is different 
from the image’s original aspect ratio.

3.8 Black-and-white or color
Click on the button Picture. A window with two tab menus shows. 
On the left tab menu you can choose whether the image must be drawn in black and 
white or in color.

3.9 Opposite meaning indicator
Click on the button Picture. A window with two tab menus shows. 
On the second tab menu you can choose an indicator that gives the picture the opposite 
meaning. You can choose a line or a cross in white, black or red.
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4. Settings for Bliss-symbols
When using the Bliss-library, the settings are partly different from the settings for symbols 
from other databases.

4.1 Size
You can select one of the pre-defined sizes (100 or 200 pixels, just around, square 
around, matrix based or square matrix based), or you can choose it on your own. If you 
set your own size, the Export Program can help you calculate the optimal width of your 
symbol (‘Auto width’ option), but you can also set another width.
Below you see four different ways of settings for the symbol ‘ape’.

Just Around      Square Around

Matrix based       Square matrix based

4.2 Symbol scale
The symbol scale determines how large your symbol will be inside your image. 100% 
means that the height of the image is 2.5 Bliss matrix units. Usually, the default of 80% 
provides a symbol size with enough space left for the text.
•  

4.3 Show matrix
Click on the button Picture. 
On the second tab menu (Indicator) you can fill in that you want a matrix behind the 
symbol. A matrix is a scheme that shows precisely how the Bliss symbols are drawn.
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4.4 Indicator
Click on the button Picture. 
On the second tab menu (Indicator) you can choose an indicator that changes the 
meaning of the Bliss symbol.
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5. Menu
The menu has the following options:

The File menu contains the command to export images, 
and the Exit command:
• Export – write the selected image to a file, print it or 

copy it to the clipboard
• Exit - Exit the export program

The Find menu contains the following actions:
• Find… - find a symbol by name or a group of letters
• Find Next – find the next symbol by name or a group 

of letters
• Find Previous – go back to the previous match
 The Options menu contains commands to change the 
category structure, the concept list and the language:
• Language – choose the language the program uses 

for the concept list and for the text that can be exported 
with the symbol of your choice

• Include subcategories – add the content (the 
concepts) of subcategories to their parent category

• Hide small categories – move the contents of small 
categories one level up; hide empty categories.

The Help menu option Manual gives direct access to the 
manual and the option About… shows version and license 
information about the Export Program.
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